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01 INTRODUCTION

This quick start is addressed to users of the NVIDIA® Control Panel software. This guide 
focuses on getting you up and running with your NVIDIA software.

For technical details on the features and benefits of the NVIDIA Control Panel software 
and details about supported products, drivers, and other software, refer to the NVIDIA 
web page — www.nvidia.com.

This chapter discusses the following major topics:

 “About the NVIDIA Control Panel” on page 2

 “Getting Support and Information” on page 4
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Chapter 01 : Introduction
About the NVIDIA Control Panel

Welcome to the NVIDIA Control Panel, designed for Microsoft® Windows® operating 
systems. You can use NVIDIA Control Panel to control your NVIDIA hardware and 
access other NVIDIA software installed on your system.

Overview 

In addition to setting up basic display configurations such as display resolution, refresh 
rate, and multiple display use, you can: 

 Tune your 3D settings with real-time preview to maximize performance or image 
quality 

 Customize how 3D applications work in your system

 Adjust your screen colors and contrast

 Set custom timings

 Control video image settings

 Change your HDTV format

 Control special workstation features such as Frame Synchronization.

Supported Operating Systems

NVIDIA Release 390 Graphics drivers are available for the following Microsoft® 
Windows® operating systems:

• Windows 7 32-bit and 64-bit Editions

• Windows 8 32-bit and 64-bit Editions

• Windows 8.1 32-bit and 64-bit Editions

• Windows 10 32-bit and 64-bit Editions

Supported NVIDIA Products

Refer to the release notes and NVIDIA driver download site for the list of products 
supported by the driver version that you have installed on your computer. 

Note: The NVIDIA Control Panel can be viewed with a desktop DPI 
scaling set to a maximum of 250%. Setting the DPI higher than 250% 
may result in some content getting cut off from view.
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Supported Languages

The NVIDIA Graphics Driver supports the following languages in the NVIDIA Control 
Panel:  
English (USA) German Portuguese (Euro/Iberian)
English (UK) Greek Russian
Arabic Hebrew Slovak
Chinese (Simplified) Hungarian Slovenian
Chinese (Traditional) Italian Spanish
Czech Japanese Spanish (Latin America)
Danish Korean Swedish
Dutch Norwegian Thai
Finnish Polish Turkish
French Portuguese (Brazil)
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 Getting Support and Information

Online Help

 To open the online help, either :

• Press F1 on your keyboard, or 

• Select Help from the NVIDIA Control Panel menu bar and then select NVIDIA 
Control Panel Help.

 Help on various topics can be viewed using the Contents, Index, or Search tabs.

Technical Support

To access the NVIDIA Technical Support web page go the following web address:

http://www.nvidia.com/page/support.html

System Information

You can get detailed information about your system and the NVIDIA Control Panel 
configuration as well as version and copyright information.

 To view copyright and version information about the NVIDIA Control Panel:

From the Help menu, select About NVIDIA Control Panel.

 To view detailed system information:

Open the System Information dialog box by either selecting System Information from 
the Help menu, or by clicking the System Information link at the lower left corner 
of the NVIDIA Control Panel. 

Click any of the tabs in the System Information dialog box. 
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02 UNDERSTANDING THE NVIDIA 
CONTROL PANEL

This chapter describes the NVIDIA Control Panel in the following sections:

 “Opening and Closing the New NVIDIA Control Panel” on page 5

 “About the NVIDIA Control Panel Interface” on page 8

Opening and Closing the New NVIDIA Control Panel

Opening the NVIDIA Control Panel

You can open the NVIDIA Control Panel in several ways:

 Right-click the Windows desktop, then click NVIDIA Control Panel from the 
context menu, or

Windows 7

 From the Classic View of the Windows Control Panel, click the NVIDIA Control Panel 
icon, or 

 From the Control Panel Home view of the Windows Control Panel, click Additional 
Options and then click NVIDIA Control Panel from the Additional Options page. 

Note: The NVIDIA Control Panel can be viewed with a desktop DPI 
scaling set to a maximum of 250%. Setting the DPI higher than 250% 
may result in some content getting cut off from view.
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Windows 8

 From the Desktop, go to Settings->Control Panel->Appearance and Personalization, then 
click NVIDIA Control Panel.
  

Windows 10

 Right-click the desktop, then select NVIDIA Control Panel.
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Closing the NVIDIA Control Panel

To close the NVIDIA Control Panel,

 From the File menu, select Exit, or 

 Click the Close box in the upper right corner of the program window.
NVIDIA Control Panel Quick Start Guide  DU-05479-390_v01 | 7



Chapter 02 : Understanding the NVIDIA Control Panel
About the NVIDIA Control Panel Interface
The NVIDIA Control Panel provides an easy-to-use interface for managing your system. 

When you start the program for the first time, the NVIDIA Control Panel opens to the 
first page listed in the navigation tree.  On subsequent visits, the control panel reopens to 
the last page visited.  The NVIDIA Control Panel user interface consists of these main 
areas, as shown in  and Figure 2.1:

 Main Task Area

 Select a Task (Navigation tree)

 Menu bar

 Toolbar  .  

.

Figure 2.1 NVIDIA Control Panel (Windows 7 Example)

Menu BarTool Bar

Select a Task Pane Control Panel Main Task Area
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Using the Main Task Area

The main task area, in the right pane, displays the application task pages. This area of the 
screen is where you will focus most of your attention as you use the NVIDIA Control 
Panel to accomplish your goals. You can access specific pages using the navigation tree in 
the Select a Task pane.

Depending on your PC manufacturer, there is a Welcome page that appears the first time 
you open the NVIDIA Control Panel after installing the driver.  On subsequent visits, the 
control panel reopens to the last page visited.  
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Using the Select a Task Pane 

The navigation tree in the Select a Task  pane shows all the primary NVIDIA Control pages 
that are installed on your system. 

The pages are grouped according to the same categories that existed in the previous 
version of the NVIDIA Control Panel. 

Figure 2.2 NVIDIA Control Panel Select a Task pane

Click to expand Click to open the
corresponding page
in the main task area. 

or collapse the
group list.
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Using the Tool Bar

The Toolbar provides quick back and forth navigation between pages. The back and 
forward buttons let you navigate sequentially among pages that you have visited.

You can also navigate directly to a previously visited page by clicking the list arrow next 
to the back button.  The drop-down menu lists all the previously visited pages in the 
queue. Click the page that you want.  

Figure 2.3 Navigation History Menu

Using the Menu Bar

The Menu bar contains standard Windows menus and menus specific to the NVIDIA 
Control Panel, such as the View and Profiles menus.

Menus that are available on the menu bar may vary, depending on the NVIDIA Control 
Panel group (such as, Display, Mobile, 3D Settings, or other group) you are using. 

File Menu

Commands related to printing, applying changes, and exiting the program are available 
on the File menu. 

Table 2.4 File Menu Commands

File Menu 
Command

Description

Page Setup ... Set up the current task page for printing. This control may not 
be available.

Print... Print the current task page. This control may not be available.

Print 
Preview....

Preview the page before sending it to the printer. This control 
may not be available.

Exit Close the NVIDIA Control Panel program.
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Edit Menu

Commands related to cutting, copying, pasting, and selecting items are available on the 
Edit menu. 

Desktop Menu

Commands related to viewing the various pages in the NVIDIA Control Panel 
application modules are available on the Desktop menu. 

Table 2.5 Edit Menu Commands

Edit Menu 
Command

Description

Cut Cut the selected text and place in the clipboard. This control 
may not be available.

Copy Copy the selected text and place in the clipboard. This control 
may not be available.

Paste Paste the text currently in the clipboard to the location of the 
Windows cursor. This control may not be available.

Select All Select all items on the current page. This control may not be 
available.

Table 2.6 Desktop Menu Commands

View Menu 
Command

Description

Add Desktop 
Context Menu

This is selected by default, and adds the NVIDIA Control Panel 
menu item to the desktop context menu.

Enable Video 
Editing Mode

Select this option to improve the video playback experience 
for some video editing applications.
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Add "Run with 
graphics 
processor" 
Option 

Select this option to add "Run with graphics processor" to the 
program context menu. 

When this option is selected, you can choose which graphics 
processor to use when starting a program as follows:

1. Right-click the program icon.

2. Click Run with graphics processor and then click the 
graphics processor to use.

The selection applies only at the time the program is 
launched.  

NOTE: This menu option appears only with systems using 
NVIDIA © Optimus™ technology. 

NOTE: Some programs require elevated user privileges in 
order to use the "Run on graphics processor" option from the 
program's right-click menu. A pop-up dialog will let you know if 
that is the case. In this case, use the controls in the NVIDIA 
Control Panel->Manage 3D Settings page to select the graphics 
processor.

Display GPU 
Activity Icon in 
Notification 
Area

Select this option so that the GPU Activity icon appears in the 
Windows notification area of the taskbar. You can then click 
the icon to see which programs and displays are using the 
NVIDIA GPU.

NOTE: This menu option appears only with systems using 
NVIDIA® Optimus™ technology.

Show 
Notification 
Tray Icon

Select to show the NVIDIA Control Panel notification tray icon 
in the Windows taskbar notification area. 

Clicking the NVIDIA Control Panel notification icon offers a 
quick way to configure key NVIDIA Control Panel settings.

Table 2.6 Desktop Menu Commands (continued)

View Menu 
Command

Description
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Help Menu

Commands related to accessing help, system information, and copyright and version 
information are available on the Help menu. 

Group-Specific Menus

These menus appear only when pages from a specific group are open.

Display Menu

This menu item appears only when a Display group page is open. 

3D Settings Menu

This menu item appears only when a 3D Settings group page is open on an SLI system. 

Table 2.7 Help Menu Commands

Help Menu Command Description

NVIDIA Control Panel 
Help

Access the NVIDIA Control Panel online help.

System Information View detailed information about your system and the 
NVIDIA Control Panel configuration.

Debug Mode Select to remove all overclocking performance and 
power settings. 

About NVIDIA Control 
Panel

View NVIDIA Control Panel version and copyright 
information.

Table 2.8 Display Menu Commands

Display Menu Command Description

Identify Displays Select to identify the displays configured with your 
system.

Show G-SYNC Visual 
Indicator

Select to verify that NVIDIA G-SYNC is being used.

Table 2.9 3D Settings Menu Commands

3D Settings Menu 
Command

Description

Show SLI Visual Indicator Select to verify that SLI rendering or SLI antialiasing 
is enabled and working.

Show Multi-GPU Visual 
Indicator

Select to verify that multi-GPU rendering or multi-
GPU antialiasing is enabled and working.
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Workstation Menu

This menu item appears only when a Workstation group page is open. 

Show PhysX Visual 
Indicator

Select to verify the type of PhysX acceleration the 
game is using - CPU or GPU - or if PhysX acceleration 
is being used at all. 

Table 2.10 Workstation Menu Commands

Workstation Menu 
Command

Description

Refresh View Select to refresh the graphical representation of the 
displays and graphics cards installed on your system.

Table 2.9 3D Settings Menu Commands

3D Settings Menu 
Command

Description
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03 ACCOMPLISHING NVIDIA CONTROL 
PANEL TASKS

The NVIDIA Control Panel provides an intuitive layout for locating graphics driver 
controls, including most of the controls that were available with the Classic NVIDIA 
Control Panel. 

 “NVIDIA Control Panel Feature List” on page 16 lists the current features available in 
the NVIDIA Control Panel.

 “NVIDIA Control Panel Groups” on page 24 provides an overview of the NVIDIA 
Control Panel pages by group.

NVIDIA Control Panel Feature List
  

Note: With Optimus systems under Windows 10, the Display con-
trols are not available if no display is connected to the NVIDIA GPU. 
This is because clone mode across display adapters is handled by 
the Windows OS and not by the NVIDIA driver.

Table 3.1 NVIDIA Control Panel Features

Feature Values (Default in bold)a Notes

Display/TV Controls

Mode control
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Chapter 03 : Accomplishing NVIDIA Control Panel Tasks
Resolution Non-HD display - the 
native resolution or the 
highest safe resolution 
from the monitor EDID is 
the default.

HD display - the highest 
progressive resolution is 
the default. 

Refresh rate 

Custom timings/resolutions

TV Signal Format Selection M/NTSC, PAL, M/PAL, N/
PAL, Select by country

Connector Selection Auto-select 

DVI 

VGA

S-Video - SDTV 

Component

Composite - SDTV 

HDMI - HDTV (Vista and 
later) 

DisplayPort - HDTV  (Vista 
and later) 

LVDS - laptop display

Available values depend 
on the actual 
connection.

Desktop Color depth Highest (32-bit)

Medium (16-bit)

Output Color Depth 8 bpc

12 bpc

Display dependent

Output Dynamic Range Full (0—255)

Limited (16—235)

Output Color Format RGB, YCbCr422 For HDMI and 
DisplayPort connections

Color Control 

Brightness 0 - 100%, (50%)

Contrast 0 - 100%, (50%)

Gamma 0.50 - 1.50, (1.00)

Digital Vibrance 0 - 100%, (0%)

Hue 0 - 359 degrees (30)

Flicker Filter 0 - 100%, (50%) For analog TVs

Table 3.1 NVIDIA Control Panel Features

Feature Values (Default in bold)a Notes
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Gray border option Disabled For analog TVs; 
presents unused black 
TV borders as gray

Content type (ITC) reported to the 
display

Auto select, Desktop 
programs, Full-screen 
videos, Photos, Movie, 
Games

Window 7 and later;

Some HDMI displays 
only - available values 
dependent on display 
support

NVIDIA G-SYNC Enable

Rotation 0, 90, 180, 270 degrees

Desktop Size and Position

Scaling mode Aspect ratio

Full-screen

No scaling

TV, VGA (with EDID), 
Digital displays, LVDS

Scaling performed on GPU

Display

Application Scaling override Off, On

Resize TV, Digital displays

Position TV, VGA

Multi-display Options

Single-display mode

Dualview (extended mode)

nView Clone Mode

Smart Clone (including Smart Clone 
Properties)

Windows 7 and later, 
select Quadro products

Video Controls “Use video player settings” is the default. If “Use 
NVIDIA settings” is selected, the following values 
apply.

Color Settings

Brightness 0 - 100%, (50%)

Contrast 0 - 100%, (50%)

Hue 0 - 100%, (0%)

Saturation 0 - 100%, (50%)

Gamma (including separate RGB) 0.3 - 3.00, (1.00)

Advanced Color Settings

Dynamic Range Full (0—255)

Limited (16—235)

Table 3.1 NVIDIA Control Panel Features

Feature Values (Default in bold)a Notes
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Dynamic Contrast Enhancement Disabled

Color Enhancement Disabled

Image Settings

Edge Enhancement 0 - 100%, (0%)

Noise Reduction 0 - 100%, (0%)

Inverse Telecine option Disabled

Internet Video Enhancement option Disabled Select GeForce 8 series 
and later GPUs

Digital Audio

Verify displays that will appear as 
audio devices in the Windows Sound 
Settings

For each audio-capable 
display, select the display 
or select “Turn off audio”.

Windows 7 and later. 
For GPUs that support 
digital audio when an 
HDMI or DisplayPort 
connection is made.

Portal to the Windows Sound Settings 
panel

HDCP

Capability verification page For GPUs that support 
HDCP.

3D Application Controls

Preferred graphics processor High-performance NVIDIA 
processor,
Integrated graphics,
Force high-performance 
NVIDIA processor use,
Force integrated graphics 
use,
Auto-select

Optimus systems

Ambient Occlusion Off, Performance, Quality Windows 7and later 

Anisotropic filtering Application-controlled, 
Off, card-specific settings 

Antialiasing - Mode Application-controlled, 
Off, Enhance the 
application setting, 
Override any application 
setting 

Antialiasing - Setting Application-controlled, 
card-specific settings 

Antialiasing - FXAA Off, On

Antialiasing line gamma Off, On

Table 3.1 NVIDIA Control Panel Features

Feature Values (Default in bold)a Notes
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Antialiasing - gamma correction Off, On

Antialiasing - transparency Off, Multisampling, 
supersampling 

Buffer-flipping mode Auto-select, 
Block transfer 

NVIDIA Quadro cards

CUDA - GPUs [All CUDA-capable 
GPUs]

DFR - Factors

DFR - Smoothness

Deep color for 3D applications Allow, disable

DSR Factors OFF
Available factors depend 
on system capability.

Examples:

1.20x (native resolution)
1.50x (native resolution)
2.00x (native resolution)
etc.

Fermi-based and later 
desktop GPUs.

Windows 7 and later

DSR Smoothness OFF

0 - 100%

Fermi-based and later 
desktop GPUs.

Windows 7 and later

Exported pixel types 8-bpp and/or RGB555 
format, None

NVIDIA Quadro cards

Maximum pre-rendered frames 0, 1, 2, 3, 4, 5, 6, 7, 8 Limits frame pre-
rendering

Monitor Technology G-SYNC, ULMB, Fixed 
Refresh Rate

Multi-display/mixed-GPU 
acceleration 

Single, Compatible, or 
Multiple display 
performance modes

Multi-GPU performance mode single-GPU, alternate 
frame rendering 1 & 2, 
split frame rendering, or 
multi-GPU antialiasing

Table 3.1 NVIDIA Control Panel Features

Feature Values (Default in bold)a Notes
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Optimize for Compute Performance Off, On Windows 10, Maxwell 
GPUs and later.

Offers significant 
improvement for some 
Compute applications. 
Care should be taken 
when turning this 
setting ON, as there can 
be unpredictable 
effects with some 
applications and 
graphics features.

OpenGL Rendering GPU Auto-select, NVIDIA Quadro FX or 
NVS cards 

Power management mode Adaptive,
NVIDIA driver controlled, 
Prefer maximum 
performance, 
Prefer consistent 
performance,
Optimal power

Windows 7 and later

Preferred Refresh Rate Application-controlled, 
Highest available

Windows 7 and later

Shader Cache On, Off

SLI performance modes single-GPU, alternate 
frame rendering 1 & 2, 
split frame rendering, or 
SLI antialiasing

Stereo - Display mode Select to match stereo 
viewing hardware

NVIDIA Quadro cards

Stereo - Enable Off, On NVIDIA Quadro cards

Stereo - Force shuttering Off, On NVIDIA Quadro cards

Stereo - Swap eyes Off, On NVIDIA Quadro cards

Stereo - Swap mode Application controlled,
Per eye,
Per Eye-pair

Texture filtering - anisotropic mip 
filter optimization

Off, On

Texture filtering - anisotropic sample 
filter optimization

Off, On

Texture filtering - Negative LOD bias Allow, Clamp

Table 3.1 NVIDIA Control Panel Features

Feature Values (Default in bold)a Notes
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Texture filtering - Quality High quality, Quality, 
Performance, High 
performance 

Balance between 
quality and 
performance

Texture filtering - Trilinear 
optimization

Off, On

Threaded optimization Off, On For systems with 
multiple CPUs

Triple buffering Off, On

Vertical sync Use the 3D application 
setting, Off, On, 
Adaptive, Adaptive (half 
refresh rate), Fast

Adaptive settings are 
available only on 
Windows 7 and later, 
and only if Monitor 
Technology is set to 
ULMB or Fixed 
Refresh Rate. 

Virtual Reality pre-rendered frames Use the 3D application 
setting, 1, 2, 3, 4

Sets the frame pre-
rendering

Whisper Mode Off: Disabled by GeForce 
Experience

On: Enabled by GeForce 
Experience and applied as 
a Global Setting. Frame 
rates are capped at 40 or 
60 fps, depending on the 
application. 

WhisperMode slider: 
Appears under Program 
Settings when enabled in 
GeForce Experience. 

Available on Pascal and 
later GPUs, on single-
GPU configurations.

Surround Configuration For systems with SLI 
ready GPUs.

PhysX Configuration For systems with PhysX-
capable GPUs, a 
minimum of 256MB 
dedicated graphics 
memory, and a 
minimum of 32 
processor cores

SLI/Multi-GPU Configuration For systems with SLI or 
multi-GPU ready GPUs.

3-way SLI Mode

Quad SLI Mode

Table 3.1 NVIDIA Control Panel Features

Feature Values (Default in bold)a Notes
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a. Defaults for the 3D application controls are for the Global Settings tab. Under the Program Set-
tings tab, Use global setting is typically the default setting.
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NVIDIA Control Panel Groups

This section provides an overview of the NVIDIA Control Panel groups.

 “Using the Display Pages” on page 24

 “Using the Video Pages” on page 24

 “Using the 3D Settings Pages” on page 25

 “Using the Stereoscopic 3D Pages” on page 25

 “Using the Mobile Pages” on page 26

 “Using the Workstation Pages” on page 26

Using the Display Pages

The actual tasks available on your system depend on your system hardware, such as the 
number and type of displays connected. Use the Display group pages to:

 Run the wizard to optimize your display configuration. 

 Change the display resolution. 

 Change the scaling on your flat panel display. 

 Adjust desktop color settings. 

 Rotate the display. 

 Adjust custom timings. 

 Configure multiple displays, including Spanning or Clone modes. 

Spanning modes are available only with Windows XP. 

 Adjust your television picture quality and video color settings for the best possible 
viewing in its environment. 

 Change the position and size of the desktop/video to best fit your television or HDTV 
(high definition television) screen. 

 Change the signal format to use for your standard television or HDTV as well as 
change country-specific signal or the HDTV format. 

 Verify the HDCP capability of your system.

 Access digital audio controls.

Using the Video Pages

The actual tasks available on your system depend on your system hardware, such as 
whether or not you have a TV connected and enabled. Use the Video page to:

 Adjust video and image color settings.
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Using the 3D Settings Pages

The actual tasks available on your system depend on your system hardware, such as 
whether or not you have an SLI-ready system. Use the 3D Settings page to:

 Change the image and rendering settings of your 3D applications and games that 
utilize Direct3D and OpenGL technology.

 Assign specific 3D settings to a game so that these settings automatically load when a 
game is launched (available under Advanced view).

 Set up your SLI or multi-GPU configuration as well as PhysX configuration.

GPU temperature monitoring and GPU overclocking features are not included in the 3D 
Settings page. To use this functionality you must install NVIDIA nTune software.

Using the Stereoscopic 3D Pages

The Stereoscopic 3D pages are part of the NVIDIA 3D Vision software for viewing 3D 
programs and games in stereoscopic 3D. Use the Stereoscopic 3D pages to:

 Control stereoscopic 3D settings.

Enable stereoscopic 3D, adjust 3D depth, select a 3D laser sight, view and set the 
keyboard shortcuts, and run the setup wizard and various tests. 

 View game compatibility. 

See a stereoscopic 3D compatibility rating for a number of games, along with possible 
issues and recommendations for each game.

 Control 3D Vision Pro settings.

NVIDIA® 3D Vision™ Pro is the professional version of the 3D Vision™ stereo 
glasses and emitter. While the 3D Vision kit uses infrared (IR) communication from 
the emitter to the stereo glasses, the 3D Vision Pro kit uses radio frequency (RF) bi-
directional communication between the stereo glasses and 3D Vision Pro hub. This 
allows multiple 3D Vision Pro hubs to be used in range of each other without conflicts. 
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Using the Mobile Pages

The Mobile group is available if the NVIDIA software is installed on a notebook 
computer under Windows XP. 

Use the Mobile page to extend your notebook computer’s battery life using NVIDIA 
PowerMizer technology 

Using the Workstation Pages

The Workstation group is available if you have an NVIDIA Quadro FX graphics card 
installed. 

The actual tasks available depend on which NVIDIA Quadro FX product you have 
installed. Use the Workstation page to:

 Synchronize your displays using frame sync or genlock technology.

 View a graphical representation of the displays and graphics cards installed on your 
system.

 Manage serial digital interface (SDI) output (requires NVIDIA Quadro FX SDI 
solution.)

 Configure Mosaic mode to combine multiple displays into a larger virtual canvass.

 Overlap the edges of adjacent displays.

Display edge blending is no longer available.
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Notice

ALL NVIDIA DESIGN SPECIFICATIONS, REFERENCE BOARDS, FILES, DRAWINGS, DIAGNOSTICS, LISTS, AND
OTHER DOCUMENTS (TOGETHER AND SEPARATELY, "MATERIALS") ARE BEING PROVIDED "AS IS." NVIDIA MAKES
NO WARRANTIES, EXPRESSED, IMPLIED, STATUTORY, OR OTHERWISE WITH RESPECT TO THE MATERIALS, AND
EXPRESSLY DISCLAIMS ALL IMPLIED WARRANTIES OF NONINFRINGEMENT, MERCHANTABILITY, AND FITNESS
FOR A PARTICULAR PURPOSE. 

Information furnished is believed to be accurate and reliable. However, NVIDIA Corporation assumes no
responsibility for the consequences of use of such information or for any infringement of patents or other
rights of third parties that may result from its use. No license is granted by implication of otherwise under
any patent rights of NVIDIA Corporation. Specifications mentioned in this publication are subject to change
without notice. This publication supersedes and replaces all other information previously supplied. NVIDIA
Corporation products are not authorized as critical components in life support devices or systems without
express written approval of NVIDIA Corporation.

HDMI

HDMI, the HDMI logo, and High-Definition Multimedia Interface are trademarks or registered trademarks of
HDMI Licensing LLC.

Macrovision Compliance Statement

NVIDIA Products that are Macrovision enabled can only be sold or distributed to buyers with a valid and
existing authorization from Macrovision to purchase and incorporate the device into buyer's products.

Macrovision copy protection technology is protected by U.S. patent numbers 5,583,936; 6,516,132;
6,836,549; and 7,050,698 and other intellectual property rights. The use of Macrovision's copy protection
technology in the device must be authorized by Macrovision and is intended for home and other limited
pay-per-view uses only, unless otherwise authorized in writing by Macrovision. Reverse engineering or
disassembly is prohibited.

OpenCL

OpenCL is a trademark of Apple Inc. used under license to the Khronos Group Inc.

Trademarks

NVIDIA and the NVIDIA logo are trademarks or registered trademarks of NVIDIA Corporation in the United
States and other countries. Other company and product names may be trademarks of the respective
companies with which they are associated.

Copyright 

© 2017 NVIDIA Corporation. All rights reserved. 
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